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Chapter 453 

Superiority by a Margin 
Tests for the Ratio of Two 
Means (Log-Normal Data) 
Introduction 
This procedure calculates power and sample size for superiority by a margin t-tests from a parallel-groups design in 
which the logarithm of the outcome is a continuous normal random variable. This routine deals with the case in 
which the statistical hypotheses are expressed in terms of mean ratios instead of mean differences.  

The details of testing the superiority (or non-unity null) hypothesis of two treatments using data from a two-group 
design are given in another chapter and they will not be repeated here. If the logarithm of the response can be 
assumed to follow a normal distribution, non-unity null hypotheses stated in terms of the ratio can be transformed 
into hypotheses about the difference. The details of this analysis are given in Julious (2004). They will only be 
summarized here.   

Superiority Testing Using Ratios 
It will be convenient to adopt the following specialized notation for the discussion of these tests.  

Parameter PASS Input/Output Interpretation 
𝜇𝜇𝑇𝑇 Not used Treatment mean. This is the treatment mean. 

𝜇𝜇𝑅𝑅 Not used Reference mean. This is the mean of a reference population.  

𝑀𝑀𝑆𝑆 SM Margin of superiority. This is a tolerance value that defines the 
magnitude of difference that is required for practical importance. This 
may be thought of as the smallest difference from the reference that is 
considered to be practically significant.  

𝜙𝜙 R1 Actual ratio. This is the value of 𝜙𝜙 = 𝜇𝜇𝑇𝑇/𝜇𝜇𝑅𝑅 at which the power is 
calculated. 

Note that the actual values of 𝜇𝜇𝑇𝑇 and 𝜇𝜇𝑅𝑅 are not needed. Only the ratio of these values is needed for power and 
sample size calculations. 

When higher means are better, the hypotheses are arranged so that rejecting the null hypothesis implies that the 
ratio of the treatment mean to the reference mean is greater than one by at least the margin of superiority. The 
value of 𝜙𝜙 at which power is calculated must be greater than 𝜙𝜙0 = 1 + |𝑀𝑀𝑆𝑆|.  

𝐻𝐻0:𝜙𝜙 ≤ 1 + |𝑀𝑀𝑆𝑆| versus 𝐻𝐻1:𝜙𝜙 > 1 + |𝑀𝑀𝑆𝑆| 

𝐻𝐻0:𝜙𝜙 ≤ 𝜙𝜙0 versus 𝐻𝐻1:𝜙𝜙 > 𝜙𝜙0 
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When higher means are worse, the hypotheses are arranged so that rejecting the null hypothesis implies that the 
ratio of the treatment mean to the reference mean is less than one by at least the margin of superiority. The value 
of 𝜙𝜙 at which power is calculated must be less than 𝜙𝜙0 = 1 − |𝑀𝑀𝑆𝑆|.  

𝐻𝐻0:𝜙𝜙 ≥ 1 − |𝑀𝑀𝑆𝑆| versus 𝐻𝐻1:𝜙𝜙 < 1 − |𝑀𝑀𝑆𝑆| 

𝐻𝐻0:𝜙𝜙 ≥ 𝜙𝜙0 versus 𝐻𝐻1:𝜙𝜙 < 𝜙𝜙0 

Log-Transformation 
In many cases, hypotheses stated in terms of ratios are more convenient than hypotheses stated in terms of 
differences. This is because ratios can be interpreted as scale-less percentages, but differences must be interpreted 
as actual amounts in their original scale. Hence, it has become a common practice to take the following steps in 
hypothesis testing.  

1. State the statistical hypotheses in terms of ratios. 

2. Transform these into hypotheses about differences by taking logarithms. 

3. Analyze the logged data—that is, do the analysis in terms of the difference. 

4. Draw the conclusion in terms of the ratio. 

The details of step 2 for the null hypothesis when higher means are better are as follows: 

𝐻𝐻0:𝜙𝜙 ≤ 𝜙𝜙0    ⇒    𝐻𝐻0:
𝜇𝜇𝑇𝑇
𝜇𝜇𝑅𝑅

≤ 𝜙𝜙0    ⇒    𝐻𝐻0: ln(𝜇𝜇𝑇𝑇) − ln(𝜇𝜇𝑅𝑅) ≤ ln(𝜙𝜙0) 

Thus, a hypothesis about the ratio of the means on the original scale can be translated into a hypothesis about the 
difference of two means on the logged scale.  

Coefficient of Variation 
The coefficient of variation (COV) is the ratio of the standard deviation to the mean. This parameter can be used 
to represent the variation in the data because of a unique relationship that it has in the case of log-normal data.  

Suppose the variable X is the logarithm of the original variable Y. That is, X = ln(Y) and Y = exp(X). Label the 
mean and variance of X as 𝜇𝜇𝑋𝑋 and 𝜎𝜎𝑋𝑋2, respectively. Similarly, label the mean and variance of Y as 𝜇𝜇𝑌𝑌 and 𝜎𝜎𝑌𝑌2, 
respectively. If X is normally distributed, then Y is log-normally distributed. Julious (2004) presents the following 
well-known relationships between these two variables 

𝜇𝜇𝑌𝑌 = 𝑒𝑒𝜇𝜇𝑋𝑋+
𝜎𝜎𝑋𝑋
2

2  

𝜎𝜎𝑌𝑌2 = 𝜇𝜇𝑌𝑌2 �𝑒𝑒𝜎𝜎𝑋𝑋
2
− 1� 

From this relationship, the coefficient of variation of Y can be found to be  

𝐶𝐶𝐶𝐶𝐶𝐶𝑌𝑌 =
�𝜇𝜇𝑌𝑌2�𝑒𝑒𝜎𝜎𝑋𝑋

2 − 1�

𝜇𝜇𝑌𝑌
 

= �𝑒𝑒𝜎𝜎𝑋𝑋2 − 1 

Solving this relationship for 𝜎𝜎𝑋𝑋2, the standard deviation of X can be stated in terms of the coefficient of variation of 
Y as 

𝜎𝜎𝑋𝑋 = �ln(𝐶𝐶𝐶𝐶𝐶𝐶𝑌𝑌2 + 1) 
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Similarly, the mean of X is 

𝜇𝜇𝑋𝑋 = ln�
𝜇𝜇𝑌𝑌

�𝐶𝐶𝐶𝐶𝐶𝐶𝑌𝑌2 + 1
� 

Thus, the hypotheses can be stated in the original (Y) scale and then the power can be analyzed in the transformed 
(X) scale. For parallel-group designs, 𝜎𝜎𝑋𝑋2 = 𝜎𝜎𝑑𝑑2, the average variance used in the t-test of the logged data. 

Power Calculation 
As is shown above, the hypotheses can be stated in the original (Y) scale using ratios or the logged (X) scale 
using differences. In either case, the power and sample size calculations are made using the formulas for testing 
the difference in two means. These formulas are presented in another chapter and are not duplicated here. 

Procedure Options 
This section describes the options that are specific to this procedure. These are located on the Design tab. For 
more information about the options of other tabs, go to the Procedure Window chapter. 

Design Tab 
The Design tab contains the parameters associated with this test such as the means, sample sizes, alpha, and 
power. 

Solve For 

Solve For 
This option specifies the parameter to be solved for from the other parameters. In most situations, you will select 
either Power or Sample Size (N1). 

Test 

Higher Means Are 
This option defines whether higher values of the response variable are to be considered better or worse. The 
choice here determines the direction of the superiority test. 

If Higher Means Are Better the null hypothesis is H0: R ≤ 1+SM and the alternative hypothesis is H1: R > 1+SM. 
If Higher Means Are Worse the null hypothesis is H0: R ≥ 1-SM and the alternative hypothesis is H1: R < 1-SM. 

Power and Alpha 

Power 
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis, 
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null 
hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of 
non-superiority when in fact the treatment mean is superior. 

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now, 
0.90 (Beta = 0.10) is also commonly used. A single value may be entered here or a range of values such as 0.8 to 
0.95 by 0.05 may be entered.  
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Alpha 
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true 
null hypothesis is rejected. In this procedure, a type-I error occurs when rejecting the null hypothesis of non-
superiority when in fact the treatment group is not superior to the reference group.  

Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that 
about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents 
the risk of a type-I error you are willing to take in your experimental situation.  

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.  

Sample Size (When Solving for Sample Size) 

Group Allocation 
Select the option that describes the constraints on N1 or N2 or both. 

The options are 

• Equal (N1 = N2) 
This selection is used when you wish to have equal sample sizes in each group. Since you are solving for both 
sample sizes at once, no additional sample size parameters need to be entered. 

• Enter N2, solve for N1 
Select this option when you wish to fix N2 at some value (or values), and then solve only for N1. Please note 
that for some values of N2, there may not be a value of N1 that is large enough to obtain the desired power. 

• Enter R = N2/N1, solve for N1 and N2 
For this choice, you set a value for the ratio of N2 to N1, and then PASS determines the needed N1 and N2, 
with this ratio, to obtain the desired power. An equivalent representation of the ratio, R, is  

N2 = R * N1. 

• Enter percentage in Group 1, solve for N1 and N2 
For this choice, you set a value for the percentage of the total sample size that is in Group 1, and then PASS 
determines the needed N1 and N2 with this percentage to obtain the desired power. 

N2 (Sample Size, Group 2) 
This option is displayed if Group Allocation = “Enter N2, solve for N1” 

N2 is the number of items or individuals sampled from the Group 2 population. 

N2 must be ≥ 2. You can enter a single value or a series of values. 

R (Group Sample Size Ratio) 
This option is displayed only if Group Allocation = “Enter R = N2/N1, solve for N1 and N2.” 

R is the ratio of N2 to N1. That is, 

R = N2 / N1. 

Use this value to fix the ratio of N2 to N1 while solving for N1 and N2. Only sample size combinations with this 
ratio are considered. 

N2 is related to N1 by the formula: 

N2 = [R × N1], 

where the value [Y] is the next integer ≥ Y. 
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For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1 (e.g., N1 = 
10 and N2 = 20, or N1 = 50 and N2 = 100). 

R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can 
enter a single or a series of values. 

Percent in Group 1 
This option is displayed only if Group Allocation = “Enter percentage in Group 1, solve for N1 and N2.” 

Use this value to fix the percentage of the total sample size allocated to Group 1 while solving for N1 and N2. 
Only sample size combinations with this Group 1 percentage are considered. Small variations from the specified 
percentage may occur due to the discrete nature of sample sizes. 

The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single or a series of values. 

Sample Size (When Not Solving for Sample Size) 

Group Allocation 
Select the option that describes how individuals in the study will be allocated to Group 1 and to Group 2. 

The options are 

• Equal (N1 = N2) 
This selection is used when you wish to have equal sample sizes in each group. A single per group sample 
size will be entered. 

• Enter N1 and N2 individually 
This choice permits you to enter different values for N1 and N2. 

• Enter N1 and R, where N2 = R * N1 
Choose this option to specify a value (or values) for N1, and obtain N2 as a ratio (multiple) of N1. 

• Enter total sample size and percentage in Group 1 
Choose this option to specify a value (or values) for the total sample size (N), obtain N1 as a percentage of N, 
and then N2 as N - N1.  

Sample Size Per Group 
This option is displayed only if Group Allocation = “Equal (N1 = N2).” 

The Sample Size Per Group is the number of items or individuals sampled from each of the Group 1 and Group 2 
populations. Since the sample sizes are the same in each group, this value is the value for N1, and also the value 
for N2. 

The Sample Size Per Group must be ≥ 2. You can enter a single value or a series of values. 

N1 (Sample Size, Group 1) 
This option is displayed if Group Allocation = “Enter N1 and N2 individually” or “Enter N1 and R, where N2 = 
R * N1.” 

N1 is the number of items or individuals sampled from the Group 1 population.  

N1 must be ≥ 2. You can enter a single value or a series of values. 
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N2 (Sample Size, Group 2) 
This option is displayed only if Group Allocation = “Enter N1 and N2 individually.” 

N2 is the number of items or individuals sampled from the Group 2 population. 

N2 must be ≥ 2. You can enter a single value or a series of values. 

R (Group Sample Size Ratio) 
This option is displayed only if Group Allocation = “Enter N1 and R, where N2 = R * N1.” 

R is the ratio of N2 to N1. That is, 

R = N2/N1 

Use this value to obtain N2 as a multiple (or proportion) of N1. 

N2 is calculated from N1 using the formula: 

N2=[R x N1], 

where the value [Y] is the next integer ≥ Y. 

For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1. 

R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can 
enter a single value or a series of values. 

Total Sample Size (N) 
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.” 

This is the total sample size, or the sum of the two group sample sizes. This value, along with the percentage of 
the total sample size in Group 1, implicitly defines N1 and N2. 

The total sample size must be greater than one, but practically, must be greater than 3, since each group sample 
size needs to be at least 2. 

You can enter a single value or a series of values. 

Percent in Group 1 
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.” 

This value fixes the percentage of the total sample size allocated to Group 1. Small variations from the specified 
percentage may occur due to the discrete nature of sample sizes. 

The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single value or a series of 
values. 

Effect Size – Ratios 

SM (Superiority Margin) 
This is the magnitude of the margin of superiority. It must be entered as a positive number. 

When higher means are better, this value is the distance above one that is required for the mean ratio (Treatment 
Mean / Reference Mean) to be considered superior. When higher means are worse, this value is the distance 
below one that is required for the mean ratio (Treatment Mean / Reference Mean) to be considered superior. 

R1 (Actual Ratio) 
This is the value of the ratio of the two means (Treatment Mean / Reference Mean) at which the power is to be 
calculated. 

When higher means are better, this value should be greater than 1+SM. When higher means are worse, this value 
should be less than 1-SM. 
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Effect Size – Coefficient of Variation 

COV (Coefficient of Variation) 
The coefficient of variation is the ratio of the standard deviation and the mean (SD/Mean). It is used to specify the 
variability (standard deviation). Note that this COV is defined on the original (not logarithmic) scale. This value 
must be determined from past experience or from a pilot study. 

To be clear, consider the following definition. Suppose data on a response variable Y are collected. This 
procedure assumes that the values of X = Ln(Y) are analyzed using a two-sample t-test. Thus, there are two sets 
of means and standard deviations: those of X labelled MX and SX and those of Y labelled MY and SY. The COV 
entered here is the COV of Y = SY/MY. For log-normal data, the following relationship exists: COV(Y) = 
SQR(Exp(SX*SX)-1) where SX is the standard deviation of the log-transformed values. 
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Example 1 – Finding Power 
A company has developed a drug for treating rheumatism and wants to show that it is superior to the standard 
drug by a certain amount. Responses following either treatment are known to follow a log normal distribution. A 
parallel-group design will be used, and the logged data will be analyzed with a two-sample t-test.  

Researchers have decided to set the margin of superiority at 0.20. Past experience leads the researchers to set the 
COV to 1.50. The significance level is 0.025. The power will be computed assuming that the true ratio is either 
1.30 or 1.40. Sample sizes between 100 and 1000 will be included in the analysis. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the procedure window. You may then make the appropriate entries as listed below, or open 
Example 1 by going to the File menu and choosing Open Example Template. 

Option Value 
Design Tab 
Solve For ................................................ Power 
Higher Means Are ................................... Better 
Alpha ....................................................... 0.025 
Group Allocation ..................................... Equal (N1 = N2) 
Sample Size Per Group .......................... 100 to 1000 by 100 
SM (Superiority Margin) .......................... 0.2 
R1 (Actual Ratio) .................................... 1.3 1.4 
COV (Coefficient of Variation) ................ 1.5 

Annotated Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results for a T-Test ──────────────────────────────────────────────────── 
R = Treatment Mean / Reference Mean 
Higher Means are Better 
Hypotheses:    H0: R ≤ 1 + SM   vs.   H1: R > 1 + SM 
 
     Bound    
Power N1 N2 N SM R0 R1 COV Alpha 
0.07477 100 100 200 0.200 1.200 1.3000 1.500 0.025 
0.11039 200 200 400 0.200 1.200 1.3000 1.500 0.025 
0.14493 300 300 600 0.200 1.200 1.3000 1.500 0.025 
0.17994 400 400 800 0.200 1.200 1.3000 1.500 0.025 
0.21389 500 500 1000 0.200 1.200 1.3000 1.500 0.025 
0.24762 600 600 1200 0.200 1.200 1.3000 1.500 0.025 
0.28099 700 700 1400 0.200 1.200 1.3000 1.500 0.025 
0.31390 800 800 1600 0.200 1.200 1.3000 1.500 0.025 
0.34624 900 900 1800 0.200 1.200 1.3000 1.500 0.025 
0.37791 1000 1000 2000 0.200 1.200 1.3000 1.500 0.025 
0.16832 100 100 200 0.200 1.200 1.4000 1.500 0.025 
0.29339 200 200 400 0.200 1.200 1.4000 1.500 0.025 
(report continues) 
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Report Definitions 
Power is the probability of rejecting a false null hypothesis. 
N1 and N2 are the number of items sampled from each population. 
N is the total sample size, N1 + N2. 
SM is the magnitude of the margin of superiority. Since higher means are better, this value is positive and is 
   the distance above one that is required to be considered superior. R0 is the corresponding superiority 
   margin bound and equals 1 + SM. 
R1 is the mean ratio (treatment/reference) at which the power is computed. 
COV is the coefficient of variation on the original scale. 
Alpha is the probability of rejecting a true null hypothesis. 
 
 
Summary Statements ───────────────────────────────────────────────────────── 
Group sample sizes of 100 in the first group and 100 in the second group achieve 7% power to 
detect superiority using a one-sided, two-sample t-test. The margin of superiority is 0.200. 
The true ratio of the means at which the power is evaluated is 1.3000. The significance level 
(alpha) of the test is 0.025. The coefficients of variation of both groups are assumed to be 
1.5.. 

 

This report shows the power for the indicated scenarios.  

 

Plots Section 
 

      
 

These plots show the power versus the sample size for two values of R1. 
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Example 2 – Validation using Another Procedure 
We could not find a validation example for this procedure in the statistical literature. Therefore, we will show that 
this procedure gives the same results as the test on differences (Two-Sample T-Tests for Superiority by a Margin 
Assuming Equal Variance)—a procedure that has been validated. We will use the same settings as those given in 
Example 1. Since the output for this example is shown above, all that we need is the output from the procedure 
that uses differences.  

To run the superiority test on differences, we need the values of SM, δ, and σ. 

𝑆𝑆𝑆𝑆 = ln(1 + 𝑆𝑆𝑆𝑆) 

= ln(1.2) 

= 0.182322 

𝛿𝛿 = ln(𝑅𝑅1) 

= ln(1.3) 

= 0.262364 

𝜎𝜎 = �ln(𝐶𝐶𝐶𝐶𝐶𝐶𝑌𝑌2 + 1) 

= ln(1.52 + 1) 

= 1.085659 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the Two-Sample T-Tests for Superiority by a Margin Assuming Equal Variance procedure 
window. You may then make the appropriate entries as listed below, or open Example 2b by going to the File 
menu and choosing Open Example Template. 

Option Value 
Design Tab 
Solve For ................................................ Power 
Higher Means Are ................................... Better (H1: δ > SM) 
Alpha ....................................................... 0.025 
Group Allocation ..................................... Equal (N1 = N2) 
Sample Size Per Group .......................... 100 to 1000 by 100 
SM (Superiority Margin) .......................... 0.182322 
δ (Actual Difference to Detect) ............... 0.262364 
σ (Standard Deviation) ........................... 1.085659 
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Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results for an Equal-Variance T-Test ───────────────────────────────────────── 
δ = μ1 - μ2 = μT - μR 
Higher Means are Better 
Hypotheses:   H0: δ ≤ SM   vs.   H1: δ > SM 
 
Power N1 N2 N SM δ σ Alpha 
0.07477 100 100 200 0.182322 0.262364 1.085659 0.025 
0.11039 200 200 400 0.182322 0.262364 1.085659 0.025 
0.14493 300 300 600 0.182322 0.262364 1.085659 0.025 
0.17994 400 400 800 0.182322 0.262364 1.085659 0.025 
0.21389 500 500 1000 0.182322 0.262364 1.085659 0.025 
0.24761 600 600 1200 0.182322 0.262364 1.085659 0.025 
0.28099 700 700 1400 0.182322 0.262364 1.085659 0.025 
0.31390 800 800 1600 0.182322 0.262364 1.085659 0.025 
0.34624 900 900 1800 0.182322 0.262364 1.085659 0.025 
0.37790 1000 1000 2000 0.182322 0.262364 1.085659 0.025 

 

You can compare these power values with those shown above in Example 1 to validate the procedure. You will 
find that the power values are identical. 
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